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• Make sure the document is stored in a safe place such that it is always available when 
working on or with the device.

• To avoid danger to individuals or the facility, read the "Basic safety instructions" section 
carefully, as well as all other safety instructions in the document that are specific to 
working procedures.

• The manufacturer reserves the right to modify technical data without prior notice. Your 
Endress+Hauser distributor will supply you with current information and updates to these 
Instructions.

Version history

Order code:

Ext. ord. cd.:

Ser. no.:

www.endress.com/deviceviewer Endress+Hauser

Operations App

XXXXXXXXXXXX

XXXXX-XXXXXX

XXX.XXXX.XX

Serial number
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2.

Document version Valid for SW version Changes to the previous version

BA01336G_01.14 18.0.3 Initial version

BA01336G_02.17 18.1.1 Unification of the W&M and the non 
W&M software packages.

BA01336G_03.23-00 18.3.3 Compatibility with Windows 11 and 
Windows Server 2022. Minor changes 
to existing functionality
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1 About this document

1.1 Document function
This manual describes the use of Tankvision Professional in a Weights and Measures 
approved environment. It should support during the installation of Tankvision Professional 
NXA85.
It is anticipated that the system would be sealed by an approved body and access to the 
sealing process would be restricted to authorized persons only.
It is only intended that Tankvision Professional supports W&M approved data for Level, 
Temperature and Gauged Volume. Calculated data is dependent upon uncontrolled variables 
such as Product density and free water level so is excluded from W&M certification.
Weights and Measures features for Tankvision Professional are limited to software version 
18.0.3 and require a valid W&M license.

It is recommended to receive a training on the system by Endress+Hauser.

1.2 Software versions and certification
Due to the certification process with weights and measures agencies, the latest 
software version might only be certified at a later stage. Also some features might be 
incompatible with the weights and measure regulations and can therefore not be 
combined.

1.3 Symbols

1.3.1 Safety symbols

Symbol Meaning

A0011189-EN

DANGER!
This symbol alerts you to a dangerous situation. Failure to avoid this situation will 
result in serious or fatal injury.

A0011190-EN

WARNING!
This symbol alerts you to a dangerous situation. Failure to avoid this situation can 
result in serious or fatal injury.

A0011191-EN

CAUTION!
This symbol alerts you to a dangerous situation. Failure to avoid this situation can 
result in minor or medium injury.

A0011192-EN

NOTICE!
This symbol contains information on procedures and other facts which do not result 
in personal injury.

DANGER

WARNING

CAUTION

NOTICE
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1.3.2 Electrical symbols 

1.3.3 Symbols for certain types of information and graphics

1.3.4 Symbols in graphics

1.4 Documentation
The following documentation types are available in the Downloads area of the 
Endress+Hauser website: www.endress.com/downloads

For an overview of the scope of the associated Technical Documentation, refer to the 
following: 

•W@M Device Viewer: www.endress.com/deviceviewer - Enter the serial number from 
the nameplate

•Endress+Hauser Operations App: Enter the serial number from the nameplate or scan 
the matrix code on the nameplate

Symbol Meaning

A0011197

Direct current
A terminal to which DC voltage is applied or through which direct current flows.

A0011198

Alternating current
A terminal to which alternating voltage is applied or through which alternating current flows.

A0011200

Ground connection
A grounded terminal which, as far as the operator is concerned, is grounded via a grounding 
system.

A0011199

Protective ground connection
A terminal which must be connected to ground prior to establishing any other connections.

Symbol Meaning

A0011193

Tip
Indicates additional information.

A0011195

Reference to page
Refers to the corresponding page number.

 ,  ,  ... Series of steps

A0018373

Result of a sequence of actions

Symbol Meaning

1, 2, 3 ... Item numbers

 ,  ,  ... Series of steps

A, B, C ... Views

A0011187

Hazardous area
Indicates a hazardous area.

A0011188

Indicates a non-hazardous location
Safe area (non-hazardous area)

)

*

1. 2. 3.

1. 2. 3.

-

.
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1.4.1 Operating instructions

1.5 Registered trademarks
Microsoft®, Windows® and Internet Explorer® 

Registered trademarks of the Microsoft Corporation

Modbus®

Registered trademark of the Modbus-IDA, Hopkinton, MA, USA

Java®

Registered trademark of Sun Microsystems, Inc.

Mozilla® Firefox®

Registered trademark of the Mozilla Foundation

Android® and Google Play® are registered trademarks of Google Inc.

iPhone® and iPad® are trademarks of Apple® Inc., registered in the U.S. and other countries.

Document number Instrument Type of Document

BA00390G/00 Tankvision Professional System Configuration

BA00391G/00 Tankvision Professional Data Communications Controller

BA00392G/00 Tankvision Professional Installation

BA00393G/00 Tankvision Professional Maintenance

BA00394G/00 Tankvision Professional Movements System Configuration

BA00395G/00 Tankvision Professional Movements Operation

BA00396G/00 Tankvision Professional System Operation

BA01293G/00 Tankvision Professional OPC Tank Data Server

BA01294G/00 Tankvision Professional OPC TG Client Configuration

BA01295G/00 Tankvision Professional Web Server/Client System Operation

BA01336G/00 Tankvision Professional Weights and Measures

BA01363G/00 Tankvision Professional Product and Tank Data Synchronization

BA01653G/00 Tankvision Professional Simple Movements

BA01654G/00 Tankvision Professional System Monitor
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2 Basic safety instructions

2.1 Requirements for the personnel
The personnel for installation, commissioning, diagnostics and maintenance must fulfill the 
following requirements: 
• Trained, qualified specialists: must have a relevant qualification for this specific function 

and task.
• Are authorized by the plant owner/operator.
• Are familiar with federal/national regulations.
• Before starting work, read and understand the instructions in the manual and 

supplementary documentation as well as the certificates (depending on the application).
• Follow instructions and comply with basic conditions.

The personnel must fulfill the following requirements for its tasks:
• Trained, qualified specialists must have a relevant qualification for this specific function 

and task.
• Are authorized by the plant owner/operator.
• Are familiar with federal/national regulations.
• Before starting work, read and understand the instructions in the manual and 

supplementary documentation as well as the certificates (depending on the application).
• Follow instructions and comply with basic conditions.

The operating personnel must fulfill the following requirements:
• Are instructed and authorized according to the requirements of the task by the facility's

owner-operator.
• Follow the instructions in this manual.

2.2 Intended use

2.2.1 Applications
Tankvision Professional is specifically designed for operators of bulk storage facilities, 
marketing terminals, refineries and pipelines. It is designed to handle all the data 
acquisition, supervisory control and monitoring required in a single fully integrated solution.

Tankvision Professional integrates all major types of tank measurement instruments into 
one system.

All measured and calculated tank parameters are accessible to your tank farm and terminal 
operators as well as to connected host systems.
Multi-user operation is provided by the inbuilt Web Server offering the opportunity to access 
data at any connected location (local or remote) e.g. for administrative and accounting 
purposes.

2.3 IT security
Our warranty is valid only if the product is installed and used as described in the Operating 
Instructions. The product is equipped with security mechanisms to protect it against any 
inadvertent changes to the settings.

IT security measures, which provide additional protection for the product and associated 
data transfer, must be implemented by the operators themselves in line with their security 
standards.
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3 Identification

3.1 Product identification
The following options are available for identification of the software:

• Nameplate specifications
• Order code with breakdown of the software features on the delivery note
• Enter serial numbers from nameplates in W@M Device Viewer: 

www.endress.com/deviceviewer - All information about the software is displayed.

3.2 Nameplate
The information that is required by law and is relevant to the device is shown on the 
nameplate, e.g.:
• Manufacturer identification
• Device name
• Order code
• Extended order code
• Serial number
• Barcode

3.3 Manufacturer address
Endress+Hauser SE+Co. KG
Hauptstraße 1
79689 Maulburg, Germany

Place of manufacture: See nameplate.

3.4 Order code and device version
To find out the version of your software, enter the order code indicated on the 
nameplate in the search screen at the following address: 
www.products.endress.com/order-ident
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4 Configuration
Weights and Measures configuration is performed using the Administration tool found in 
the Start Menu:

NXA85_WM_111

This is protected by two levels of security. Initially a user must have "View" rights granted by 
Tankvision Professional security. In addition to the standard level of security, the W&M 
certificate can only be modified by entering a certificate password.

4.1 Certificate Configuration
This will normally be performed by the relevant authorizing body.

NXA85_WM_002

4.1.1 New Certificate
The steps to create a certificate are as follows:

Open the administration screen and select Certificate → New from the menu bar.

In the Create Certificate window that opens enter and confirm the certificate password. 
Complete the fields for the Certificate Creator Details and click OK to create the 
certificate.

1.

2.
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NXA85_WM_003

An Open certificate will be created.

NXA85_WM_112

W&M items can only be sealed whilst the certificate is open. The certificate will remain open 
for a period of 10 minutes with no activity before automatically closing.
To manually close the certificate either close the window by clicking the cross in the top right 
corner, select Certificate → Close from the menu bar or click on the Certificate toolbar 
button  .

NXA85_WM_006

4.1.2 Reset Audit Trail
Resetting the Audit Trail will remove all of the W&M seals from the software, Tank 
Capacity Tables, Tanks and Gauges.

The Audit trail can be reset from Certificate → Reset Audit Trail in the menu bar.

3.
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NXA85_WM_007

The audit trail can only be reset whilst the certificate is Open. If not already open you will be 
prompted to enter the certificate password to continue.

NXA85_WM_008

A screen will open to enter the details of the agent resetting the audit trail.

NXA85_WM_009

Enter the details and any optional comments and click OK to continue. If any details are 
missing a reminder box will open, click OK to return and enter the missing details.

NXA85_WM_010
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NXA85_WM_011

Ensure that this process takes no longer than 10 minutes or the open certificate will close 
and you will be prompted to re-enter your password.

NXA85_WM_012

A new entry will be made into the Audit Trail to record the reset and a check will be made to 
validate the legally significant software.

NXA85_WM_113

Audit entries are not deleted. A new option will be added to the View menu to display only 
the record entries made since the last reset. To view entries made prior to the reset select 
View → Certificate Records.

NXA85_WM_014

The final option in the View menu, All Records, is used to display historical records when 
subsequent New certificates have been created, records for any older certificates will not be 
deleted but they are no longer verifiable so will be hidden by default.
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4.2 Sealing Software
In order to seal the software the certificate must be Open.
Click the certificate icon  on the toolbar and enter the correct password to open the 
certificate.

NXA85_WM_015

Alternatively attempting to seal an item whilst the certificate is "Closed" will open the 
password entry box.
An entry will be made into the event log to indicate that the certificate has been opened.

NXA85_WM_114

To check the status of the software seals click the Seal Software icon  on the toolbar.

NXA85_WM_115

A window opens to show the seal status and validity of the legally significant software.
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NXA85_WM_116

The software can be sealed by clicking the Seal  icon.
The seal details will update with the new status and the seal icon will "grey out" to indicate 
that it will serve no further purpose whilst the seal is intact.

NXA85_WM_117

NXA85_WM_022

The window can be closed using the close window cross or the Close button.
An entry will be made into the Audit Trail to indicate that the software has been sealed.

NXA85_WM_118

4.3 Sealing Tank Capacity Tables
In order to seal the Tank Capacity Tables the certificate must be Open.
Click the certificate icon  on the toolbar and enter the correct password to open the 
certificate.
Click on the Seal Tank Capacity Tables icon to open the Tank Capacity Table Seals 
window.
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NXA85_WM_119

NXA85_WM_120

Select the table to be sealed. Multiple tables may be selected by using the standard Windows 
"Shift" and "Ctrl" selection methods. Clicking the  icon selects all Unsealed tables. Once at 
least one unsealed table has been selected the seal icon  becomes active.
Click the seal icon to seal the selected Tank Capacity table(s).

NXA85_WM_122

The window can be closed using the close window cross or the Close button.
An entry will be made into the Audit log for each table that has been sealed.



Configuration Tankvision Professional NXA85 - Weights and Measures

16 Endress+Hauser

NXA85_WM_123

4.3.1 Tank Capacity Table Locked Parameters
When a Tank Capacity Table is sealed the following items are locked and can no longer be 
edited.

4.4 Sealing Gauges
In order to seal gauges the certificate must be Open.

Click the certificate icon  on the toolbar and enter the correct password to open the 
certificate.
Click on the Seal Gauges icon to open the Gauge Configuration Seals window.

Field Description

TableID User-readable table identifier

Role Indicates the table’s purpose (normal, water, hydrostatic deformation)

Type Indicates the table’s type (innage, ullage, delta innage, delta ullage, polynomial)

Valid From The date from which the table is deemed valid

Points Table The table containing the level/volume data for the capacity table

Polynomial Table The table containing the polynomial data for the capacity table (if defined as a 
polynomial table)

P Factor for the polynomial table
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NXA85_WM_124

NXA85_WM_125

Select the gauge to be sealed. Multiple gauges may be selected by using the standard 
Windows ’Shift’ and ’Ctrl’ selection methods. Once at least one unsealed gauge has been 
selected the seal icon  becomes active. Clicking on the seal icon allows selection of the 
type of seal to apply.

NXA85_WM_126

Gauges may be sealed for Level, Temperature or Inventory. If gauges are sealed for 
inventory, then they are implicitly sealed for level and temperature as well. Once the type of 
seal(s) required have been selected, the OK button will become active and can be clicked. 
Clicking the OK button will apply the selected seal types to the selected gauges.
The window can be closed using the close window cross or the Close button.
An entry will be made into the Audit Trail for each device that has been sealed and each 
change to manual data permissions.
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NXA85_WM_127

4.4.1 Gauge Locked Parameters
When a Tank is sealed the following items are locked and can no longer be edited.

Level Temp. Inv. Field Description

   Device Address The address of the instrument in the field

   Tank Address The address of the instrument if an intermediary field 
communications device is to be used

   DC Address The address of the field communications interface (if 
required by the field equipment)

   Backup DC Address The address of an alternative field communications 
interface when deployed in a redundant configuration

   Port The port used to communicate with the field equipment

   Backup Port The alternative port to be used when deployed in a 
redundant configuration

   Device Type The type of the gauge

   DCC Host 
Configuration

Modbus Host map configuration

  Auxiliary 1 ... 
Auxiliary 16

Auxiliary item data fields

 Type of Instrument Required for gauge types which offer different protocols 
for level. Specifies the protocol (’A’ = GPP, ’B’ = GPU etc.) 
used to read level from the gauge

 Type of Record Required for gauge types which offer different requests 
for level. Specifies the request used to read level from the 
gauge

 Dimensions:
Level
Temperature
Pressure
Density

Units used when reading Level from the device
Units used when reading Temperature from the device
Units used when reading Pressure from the device
Units used when reading Density from the device

 Float Diameter Diameter of the gauge float

 Float Weight Weight of the gauge float

 Float Reference 
Density

The density of the fluid in which the float was calibrated



Tankvision Professional NXA85 - Weights and Measures Configuration

Endress+Hauser 19

4.4.2 Port Locked Parameters
When any gauge is sealed on a port, the following items are locked and can no longer be 
edited.

4.5 Sealing Tanks
In order to seal tanks the certificate must be Open.
Click the certificate icon  on the tool-bar and enter the correct password to open the 
certificate.
Click on the Seal Tanks icon to open the Tank Configuration Seals window.

NXA85_WM_128

NXA85_WM_129

Select the tank to be sealed. Multiple tanks may be selected by using the standard Windows 
’Shift’ and ’Ctrl’ selection methods. Once at least one unsealed tank has been selected the 
seal icon  becomes active. Clicking on the seal icon allows selection of the type of seal to 
apply.

 Gauge Temperature 
Coefficient

The linear coefficient of thermal expansion for the gauge 
and its mountings

 Gauge Reference 
Temperature

The temperature at which the gauge was calibrated

Port Type Field Description

Network Port Address The remote network address to connect to

Network Port Port The TCP port for the remote connection

Serial Port COM Port The COM port that the loop is connected to

All DCC Address The address of the slave machine when using the Datacon Protocol

Level Temp. Inv. Field Description



Configuration Tankvision Professional NXA85 - Weights and Measures

20 Endress+Hauser

NXA85_WM_130

Tanks may be sealed for Level, Temperature, Inventory or Manual Data. If tanks are sealed 
for inventory, then they are implicitly sealed for level and temperature as well. Once the type 
of seal(s) required have been selected, the OK button will become active and can be clicked. 
Clicking the OK button will apply the selected seal types to the selected tanks.

NXA85_WM_131

It is also possible to change whether or not manual product levels and manual product 
temperatures can edited if the relevant seal is in place. The default setting for sealed tanks 
is ’Manual Data Allowed’ . Tanks can be toggled between manual data allowed and 
denied by selecting the device and clicking the  and  icon. The toolbar button to allow/
deny manual data cannot be used if the tank is sealed for Manual Data.
The window can be closed using the close window cross or the Close button.
An entry will be made into the Audit Trail for each tank that has been sealed and each 
change to manual data permissions.
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NXA85_WM_135

4.5.1 Tank Locked Parameters
If any tank on a site is sealed, then the site itself is sealed to prevent modification of the tank 
ID which is made up of the site name and tank name. This means that the site name is locked 
and can no longer be edited.
If any tank in the system is sealed for level, then the system settings for air density and 
gravitational constant are sealed. In addition if any tank in the system is sealed for inventory, 
then the system setting for water density is also sealed. This means the corresponding values 
in the system settings are locked and can no longer be edited.
If a tank is sealed in any way then the name and the device map for the tank are locked and 
can no longer be edited.

Level

When a Tank is sealed for level the following items are locked and can no longer be edited.

Field Description

Product Level Source The alternative live data source for product level

Product Tank Capacity Table The tank capacity table to be used to calculate volumes given a product level

Inventory Control (1) Indicates whether the level read by the gauges on the tank are innage or 
ullage

Base Pressure Height Enabled Indicates whether base pressure height is used

Base Pressure Height The base pressure height to be used in calculating the product level

Product Pressure Height Enabled Indicates whether product pressure height is to be used

Product Pressure Height The product pressure height to be used in calculating the product level

Vapour Pressure Height Enabled Indicates whether vapour pressure height is to be used

Vapour Pressure Height The vapour pressure height to be used in calculating the product level

Reference Height The defined reference height of the tank

Product Level Mode Indicates whether the product level is a manual value.   Only locked when 
manual data is denied for the tank
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Temperature

When a Tank is sealed for temperature the following items are locked and can no longer be 
edited.

Inventory

When a Tank is sealed for inventory the following items are locked and can no longer be 
edited.

Manual Product Level The manual product level for the tank. Only locked when manual data is 
denied for the tank

Field Description

Product Temperature Source The alternative live data source for product temperature

Product Temperature Mode Indicates whether the product temperature is a manual value. Only locked 
when manual data is denied for the tank

Manual Product Temperature The manual product temperature for the tank. Only locked when manual 
data is denied for the tank

Field Description

Product Inventory Flags Denotes how inventory calculations are to be performed for the tank

Tank Shape Denotes the shape of the tank

API/ASTM Table Volume correction control method

Method of Calculation Sets and locks inventory controls specific to the standard selected

JIS Calculation Method Specifies the handling of floating roof corrections within JIS calculations

Vapour Calculation Specifies the vapour correction calculations that will be performed as part 
of the inventory calculations

Adjustment Volume A fixed volumetric adjustment (either +ve or -ve) applied to the volume 
obtained from the Tank Capacity Table

Calibration Density The density of the medium in a tank when that tank was calibrated (only 
used in JIS based calculations)

Roof Weight The weight of the floating roof

Roof Support Legs Up The point at which the roof legs are supporting the full weight of the roof 
when the legs are in the ’up’ or operational position

Roof Support Legs Down The point at which the roof legs are supporting the full weight of the roof 
when the legs are in the ’down’ or maintenance position

Roof Floating Legs Up The point at which the roof just ceases to be resting on its legs when the 
legs are in the ’up’ or operational position

Roof Floating Legs Down The point at which the roof just ceases to be resting on its legs when the 
legs are in the ’up’ or operational position

Shell Insulation Factor Value between 0 and 1. 0 for un-insulated storage, 1 for completely 
insulated storage

Shell Expansion Coefficient Expansion coefficient of the material the tank is constructed from

Shell Reference Temperature Normally the same reference temperature used for VCF calculations

Vapour Density The density of the product in the vapour space of the tank

Thermal Expansion Coefficient The volumetric expansion coefficient factor of the liquid product in the 
tank, specified as a ratio per degree temperature change (/°C or /°F)

Temperature Correction Factor The volumetric or cubical expansion factor of the liquid product in the tank, 
specified as a ratio per degree temperature change (/°C or /°F)

Field Description
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Manual Data

When a Tank is sealed for manual data the following items are locked and can no longer be 
edited.

Density Correction Factor A factor representing the temperature change of density of the liquid 
product in the tank specifies as the density change per degree temperature 
change

Manual VCF Value used for volume corrections when API table selected is ’Manual’

Product Reference Temperature The temperature at which standard volumes are calculated

Molecular Mass The molecular mass of the product in the tank

Liquid Volume Ratio The ratio of ’vapour volume’ to ’equivalent liquid volume’ at standard 
reference temperature

Chemical Concentration Chemical Concentration, Strength × volume or Strength × Mass value for 
the product. This field is determined by the API/ASTM table selected

Enraf Polynomial Constants Only available when an Enraf volume correction method is selected

Water Table The water table to be used to calculate volumes given a water level

Hydrostatic  Deformation Table The hydrostatic deformation table to be used to calculate volumes

Density Table The density table to be used to calculate volumes when the density 
calculation method is selected

Hybrid Density Enabled Indicates if hybrid density calculations are to be performed for the tank

Hybrid Density Includes Water Indicates if hybrid density calculations for the tank are to include water

Hybrid Density Uses P3 Indicates if hybrid density calculations are to be performed using P3

Hybrid Min Level The minimum level to be used for hybrid density calculations for a tank

Hybrid Level Hysteresis The hysteresis to be used before resuming hybrid density calculations for a 
tank

Hybrid Min Pressure The minimum pressure to be used for hybrid density calculations for a tank

Vapour Pressure Source The alternate live data source for vapour pressure for the tank

Field Description

Product Level Mode Indicates whether the product level is a manual value

Manual Product Level The manual product level for the tank

Product Temperature Mode Indicates whether the product temperature is a manual value

Manual Product Temperature The manual product temperature for the tank

Product Pressure Mode Indicates whether the product pressure is a manual value

Manual Product Pressure The manual product pressure for the tank

Oil Depth Mode Indicates whether the oil depth is a manual value

Manual Oil Depth The manual oil depth for the tank

Reference Density Mode Indicates whether the reference density is a manual value

Manual Reference Density The manual reference density for the tank

Observed Density Mode Indicates whether the observed density is a manual value

Manual Observed Density The manual observed density for the tank

Observed Temperature Mode Indicates whether the observed temperature is a manual value

Manual Observed Temperature The manual observed temperature for the tank

Air Pressure Mode Indicates whether the air pressure is a manual value

Manual Air Pressure The manual air pressure for the tank

Air Temperature Mode Indicates whether the air temperature is a manual value

Field Description
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Manual Air Temperature The manual air temperature for the tank

Free Water Volume Mode Indicates whether the free water volume is a manual value

Manual Free Water Volume The manual free water volume for the tank

Free Water Mode Indicates whether the free water is a manual value

Manual Free Water The manual free water for the tank

Suspended Sediment The suspended sediment for the tank

Suspended Water The suspended water for the tank

Vapour Pressure Mode Indicates whether the vapour pressure is a manual value

Manual Vapour Pressure The manual vapour pressure for the tank

Vapour Temperature Mode Indicates whether the vapour temperature is a manual value

Manual Vapour Temperature The manual vapour temperature for the tank

Vapour Density Mode Indicates whether the vapour density is a manual value

Manual Vapour Density The manual vapour density for the tank

Base Pressure Mode Indicates whether the base pressure is a manual value

Manual Base Pressure The manual base pressure for the tank

Stratification Status Mode Indicates whether the stratification status is a manual value

Manual Stratification Status The manual stratification status for the tank

Adjustment Volume A fixed volumetric adjustment (either +ve or –ve) applied to the volume 
obtained from the Tank Capacity table

Observed Pressure The manual observed pressure for the tank

Field Description
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5 Client/Server Systems
Client PCs connected to a Weights and Measures sealed Server must have a secure, 
encrypted connection to the database on the server. In order to be valid for weights and 
measures the software on the client PC must also be sealed. In most cases the supplied 
commissioning tool can be used to set up the encrypted connection. How- ever, in a few, 
advanced, cases it may be necessary to set the encrypted connection up manually. For details 
of how to set up a secure, encrypted connection manually see Appendix A (Server 
Configuration, → ä 69) and Appendix B (Client Configuration, → ä 82).

5.1 Create an SQL Certificate
In order to encrypt the connection between the Server and the client an SQL database 
certificate will be created by the server and imported into the client. There is a tool to create 
the certificate in the Start menu.

NXA85_WM_136

Click to launch the commissioning tool.

NXA85_WM_038

Click the Next button to proceed with the wizard.
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5.1.1 Fully Qualified Domain Name
Connection encryption for SQL server is only supported for machines that have an FQDN 
(fully qualified domain name). If the machine does not currently have an FQDN, it must 
either be joined to a domain or have a primary DNS suffix set. If the machine does not 
currently have an FQDN then the following page is displayed:

NXA85_WM_137

NXA85_WM_138

To join a domain, a valid user name and password for the domain must be specified.
Click the Next button to join the domain or add a primary DNS suffix to the machine name.
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NXA85_WM_139

In order to complete the action it is necessary to restart the machine. To prevent the machine 
automatically restarting when the Finish button is clicked, untick the Restart Computer 
Now box.
When the machine has been restarted it will be necessary to run the commissioning tool 
again to set up the certificate for SQL server.

Hosts file
If the user sets a primary DNS suffix rather than joining a full domain it may be 
necessary to edit the windows hosts file to enable reliable address lookup. The hosts 
file is a text file located at C:\Windows\System32\drivers\etc\hosts. The user should 
edit the file and place an entry for each machine (for example, in the case of one client 
and one server there will be two entries).
Each entry takes the form:
<IP Address> <ComputerName>.<Primary DNS Suffix>

5.1.2 Certificate Already Installed
If a suitable certificate is already installed in the certificate store on the machine and SQL 
server has been configured to use a certificate, then the certificate is validated. If the 
validation is successful, then the following page is displayed:
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NXA85_WM_140

NXA85_WM_141

If the configuration of the machine has been changed it may be necessary to restart the 
machine in order for the configuration to take effect. The Restart Computer Now option will 
only be available if this is the case. To prevent the machine automatically restarting untick 
this box.

5.1.3 Certificate  Required
If the machine has an FQDN, but does not have a suitable certificate already installed in the 
certificate store on the machine, then it is necessary to import or create a certificate. The 
next page in the wizard will present a number of options for doing this.

Import Certificate

If a certificate has been received from a certification authority it is possible to import it using 
the Import certficate option.
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NXA85_WM_142

Click the Next button to proceed with the wizard.

NXA85_WM_143
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NXA85_WM_144

Either enter the path to the certificate file to be imported, or click the browse to select the 
file to be imported. If a certificate file which requires a password is selected, then a field will 
be displayed allowing entry of the password.
Click the Next button to import the certificate.

NXA85_WM_145
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NXA85_WM_146

If the configuration of the machine has been changed it may be necessary to restart the 
machine in order for the configuration to take effect. The Restart Computer Now option will 
only be available if this is the case. To prevent the machine automatically restarting untick 
this box.

Create Self-Signed Certificate

It is possible to create a self-signed certificate to be used to encrypt the SQL connection. This 
is not as secure as using a certificate provided by a certification authority and may not be 
acceptable to local weights and measures officials.

NXA85_WM_147

Click the Next button to proceed with the wizard.
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NXA85_WM_148

The issuer and subject will automatically be populated with the details required to produce 
a suitable certificate. Enter a certificate name and, optionally, amend the validity dates.
Click the Next button to create the certificate.

NXA85_WM_149

The certificate will be required by any client PCs that require an encrypted SQL connection 
to the server. In order to achieve this it is necessary to export the certificate that has been 
created. Enter or browse to the location to which the certificate is to be exported.
In order for the configuration to take effect it is necessary to restart the machine. To prevent 
the machine automatically restarting when the Finish button is clicked untick the Restart 
Computer Now box.

Create Request File

This option is used to generate a request file containing all the information required for a 
certification authority to create a suitable certificate for the machine.
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NXA85_WM_150

Click the Next button to proceed with the wizard.

NXA85_WM_151

Fill in the details for the certificate request. All fields are mandatory. Take careful note of the 
location to which you export the request file.
Click the Next button to create the request file.
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NXA85_WM_152

When the certificate is received from the certification authority it will be necessary to run 
the commissioning tool again and import the file that has been supplied.

Use Installed Certificate

If there is a suitable certificate available in the certificate store on the machine it is possible 
to use it to encrypted the SQL server connection.

NXA85_WM_153

Only certificates that are suitable will be listed. Select the certificate to be used and then click 
the Next button.
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NXA85_WM_154

The certificate will be required by any client PCs that require an encrypted SQL connection 
to the server. In order to achieve this it is necessary to export the certificate that has been 
selected if it is not already available. Enter or browse to the location to which the certificate 
is to be exported.
In order for the configuration to take effect it is necessary to restart the machine. To prevent 
the machine automatically restarting when the Finish button is clicked untick the Restart 
Computer Now box.

5.2 Apply SQL Certificate to Client
Once a certificate has been created for the server machine it must be imported to all the 
client machines for which weights and measures validation is required. Open the weights 
and measures commissioning tool as for the server.

NXA85_WM_038

Click the Next button.
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5.2.1 Certificates Already Installed
If suitable certificates are already installed for all of the server machines then details of the 
certificates will be displayed for each server.

NXA85_WM_155

5.2.2 Certificates  Required
If there is no suitable certificate installed for one or more of the server machines, then it is 
necessary to import a suitable certificate previously exported from the server machine or 
supplied by a certification authority.

NXA85_WM_156

Click on the Import button and browse for the previously exported certificate file.
To exit the wizard click the Finish button.

5.3 Weights and Measures Administration in Client
The weights and measures module on client machines operates with a simplified set of 
controls.
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As with the server machine the operator is able to Open and Close the Certificate, Preview 
and Print the Events report and seal the software for the client machine.
It is not possible to seal or unseal Tank Capacity Tables, Gauges or Tanks from a client 
machine, these functions are restricted to the server.
One additional function, Server Connections (  ) is added to the client Administration 
tool.

NXA85_WM_050

5.3.1 Encrypting Connections
Data displayed on a client machine can only be considered weights and measures compliant 
when the Server/Client connection is Encrypted.
Ensure the server certificate has been applied to the client PC and select the Server 
Connections option (  ) from the Weights and Measures Administration tool.
The following window will open. Select a server from those available and click  to toggle 
between encrypted  and unencrypted  connection.

NXA85_WM_053

NXA85_WM_054

Any weights and measures sealed data will display the appropriate indicator when the 
connection is encrypted. If the connection is not encrypted the indicators will not be present 
even if the data is weights and measures compliant.
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6 Weights and Measures Indicators
Level, Temperature and Gauged Volume data items which have a valid Weights and 
Measures seal are identified with a # symbol. This indication is shown on the Home Page, 
Single Tank view and Grid view displays.
Gauged volume will only be considered Weights and Measures sealed if the Tank, the 
Primary device and Associated Tank Capacity table are ALL sealed.

Gauged Volume is not dependant upon sealed Temperature.

NXA85_WM_056

NXA85_WM_057

NXA85_WM_058

6.1 Tank Capacity Tables
When Tank Capacity Tables have been sealed this is indicated in the Tank Capacity Table 
utility by the presence of a seal symbol  next to the table ID.
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NXA85_WM_059

When a tank capacity table is sealed only the comments can be edited.

The reference height and shell capacity fields are not part of the tank capacity table 
itself. These are taken from the associated tank and will be sealed if the associated tank 
is sealed, NOT the tank capacity table.

6.2 Density Tables
When Density Tables have been sealed this is indicated in the Density Table utility by the 
presence of a seal symbol  next to the table ID.
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NXA85_WM_157

When a density table is sealed only the comments can be edited.

6.3 Configuration Tool
When Tanks or Gauges have been sealed this is indicated in the configuration tool by the 
presence of a seal symbol  in the details pane.

NXA85_WM_158

In addition, any fields that are sealed are specifically indicated to make it clear which fields 
cannot be edited because they are sealed rather than because of any functional or security 
restrictions.
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NXA85_WM_159

When a tank has been sealed for level the tank capacity table selection for that tank 
becomes fixed.
This is indicated by a seal symbol   on the Tank TCT details pane. This is not an 
indication of the seal status of the Tank Capacity Table itself, the seal will be present 
even if the TCT is not sealed to indicate that the tank is sealed for level and therefore 
the table selection cannot be changed.
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NXA85_WM_160
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7 Backup and Restore
If any Weights and Measures seals are accidentally or intentionally broken it is possible to 
restore Tankvision Professional to a known good Weights and Measures approved state 
using the Backup and Restore utility.
Any Weights and Measures audit events since the last backup will be lost so it is strongly 
recommended that backups are taken at regular intervals.
Restoring a backup of an approved Weights and Measures configuration may be performed 
at any time without requiring the Weights and Measures Authority to edit the certificate.

7.1 Backing up a Database
Select Backup and Restore from the Windows Start menu.

NXA85_WM_161

In the window that opens select Backup and click the Next button.

NXA85_WM_162
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NXA85_WM_163

The backup will be saved to a directory named with the current date (this can be renamed 
later).
Use the default location or select a location to save the backup and click the Next button.

NXA85_WM_164

The backup will be saved to the chosen location. Click the Finish button, when prompted, to 
close the wizard.
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7.2 Restoring a Database
To restore a saved database close down all Tankvision Professional windows. Select Backup 
and Restore from the Windows Start menu and in the window that opens select the Restore 
option and click the Next button.

NXA85_WM_165

Select Existing Backup and click the Next button.

NXA85_WM_166

Select the directory containing the backup of the database and click the Next button.
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NXA85_WM_167

Verify that the directories to which the databases will be restored are correct and then click 
the Next button.

NXA85_WM_168

Confirm that you wish to overwrite the existing database.
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NXA85_WM_169

The backup of the database will be restored. When prompted, click the Finish button to close 
the wizard. 

NXA85_WM_170



Breaking Weights and Measures Seals Tankvision Professional NXA85 - Weights and Measures

48 Endress+Hauser

8 Breaking Weights and Measures Seals
There may be times when it is necessary to break one (or more) of the Weights and 
Measures seals.
To break Weights and Measures seals you must log in as a user with sufficient access rights 
to view the Weights and Measures settings. It is not necessary to enter the Weights and 
Measures Certificate password to break seals as this is only required when sealing the 
system.

8.1 Unsealing Tank Capacity Tables
Weights and Measures configuration is performed using the Administration tool in the 
start menu:

NXA85_WM_171

Click on this link and, if not already logged in with sufficient access rights, you will be 
prompted for a password.

NXA85_WM_172

To get more details of the access rights required, click the Information icon  .

NXA85_WM_174

Click on the icon to open the Tank Capacity Table Seals window.
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NXA85_WM_175

NXA85_WM_176

Select the table to be unsealed. Multiple tables may be selected by using the standard 
Windows "Shift" and "Ctrl" selection methods. Clicking the  icon selects all Sealed tables. 
Once at least one sealed table has been selected the unseal toolbar button  becomes 
active. Click the Unseal button to unseal the Tank Capacity table(s).
Confirm your selection in the window that pops open.

NXA85_WM_177

The selected tank capacity tables will now be shown as unsealed. The Tank Capacity Table 
Seals window can be closed using the Close Window cross or the Close button.
An entry will be made into the Audit Trail for each table that has been unsealed.
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NXA85_WM_178

8.2 Unsealing Gauges
Click on the Seal Gauges icon to open the Gauge Configuration Seals window.

NXA85_WM_179

NXA85_WM_180

Select the gauge to be unsealed. Multiple gauges may be selected by using the standard 
Windows ’Shift’ and ’Ctrl’ selection methods. Once at least one sealed gauge has been 
selected the unseal toolbar button  becomes active. Click the unseal button to unseal the 
Gauge(s).
Unlike sealing gauges where the user may select what to seal, unsealing gauges will always 
remove all of the seals for a gauge.

Confirm your selection in the window that pops open.
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NXA85_WM_181

The selected gauges will now be shown as unsealed. The Gauge Configuration Seals window 
can be closed using the Close Window cross or the Close button. An entry will be made into 
the Audit Trail for each gauge that has been unsealed. 

NXA85_WM_182

8.3 Unsealing Tanks
Click on the Seal Tanks icon to open the Tank Configuration Seals window.

NXA85_WM_183
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NXA85_WM_184

Select the tank to be unsealed. Multiple tanks may be selected by using the standard 
Windows ’Shift’ and ’Ctrl’ selection methods. Once at least one sealed tank has been selected 
the Unseal tool-bar button  becomes active. Click the Unseal button to unseal the 
Tank(s). Unlike sealing tanks where the user may select what to seal, unsealing tanks will 
always remove all of the seals for a tank.
Confirm your selection in the window that pops open.

NXA85_WM_185

The selected tank will now be shown as unsealed. The Tank Configuration Seals window can 
be closed using the Close Window cross or the Close button. An entry will be made into the 
Audit Trail for each tank that has been unsealed.

NXA85_WM_186
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9 Reports

9.1 Weights and Measures Configuration Reports
The system automatically generates the following reports:
• Weights and Measures Audit Trail
• Weights and Measures Software Seals
• Weights and Measures Tank Capacity Table Seals.
• Weights and Measures Gauge Configuration Seals
• Weights and Measures Tank Configuration Seals

These can be previewed or printed "On Demand" by opening the appropriate page from the 
Weights and Measures Administration screen and selecting the Print Preview  or 
Print  icons from the toolbar.
When a report is printed, either directly or from the print preview window an audit record is 
written identifying the report and when it was printed.

9.1.1 Audit Trail Report
Open the Weights and Measures → Administration screen. Select which records to print 
from the view menu and select either Print or Preview.

NXA85_WM_014

NXA85_WM_187

If print is selected the report will be sent directly to your default printer, however if Preview 
is selected the report can be viewed on screen prior to printing. The report can be printed 
directly from the previewer utility by clicking the printer icon  in the top left corner of the 
screen.
When printing from the previewer it is possible to select a printer to send the report to. It is 
never possible to select any particular page or range of pages to print. This is to comply with 
the requirement for a complete audit trail.
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NXA85_WM_087

NXA85_WM_088
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9.1.2 Software Seals Report
Open the Weights and Measures → Administration screen. Select the Seal Software icon 
from the view menu and select either Print or Preview.

NXA85_WM_189

NXA85_WM_090

The Software Seals report lists all of the legally significant software along with its validity 
status, the date the software was sealed and the date the software was last verified by the 
application. The software seals are verified every 6 hours however since opening the 
software seals screen initiates the verification process this should always be the current 
date/time.

As with the Audit Trail report, the Software Seals report will be printed directly to your 
default printer.
You can select an alternative printer by printing the report from the previewer but again 
there is no option to select the individual pages to print.

NXA85_WM_190

9.1.3 Tank Capacity Table Seals Report
Open the Weights and Measures → Administration screen. Select the Seal Tank Capacity 
Tables icon from the view menu and select either Print or Preview.
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NXA85_WM_191

NXA85_WM_192

The report lists the tables alphabetically in ascending order of Table ID. Any tables that have 
a Weights and Measures seal applied are indicated with a seal symbol in the left hand 
column. The date the table was sealed is given. The Valid From and Valid To dates are only 
applicable if set when the table was configured.

As with the Audit Trail report, the Tank Capacity Table Seals report will be printed directly 
to your default printer.
You can select an alternative printer by printing the report from the previewer but again 
there is no option to select the individual pages to print.

NXA85_WM_193

9.1.4 Gauge Configuration Seals Report
Open the Weights and Measures → Administration screen. Select the Seal Gauges 
Configuration icon from the view menu and select either Print or Preview.
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NXA85_WM_194

NXA85_WM_195

The report lists the gauges alphabetically in ascending order of instrument tag. Any gauges 
that have weights and measures seals applied are indicated with seal symbols in the left 
hand column. There can be up to 3 seals per gauge, one for Level (Left hand side), one for 
Temperature (Center) and one for inventory (Right hand side). The date the device was 
sealed is given.

As with the Audit Trail report, the Gauge Configuration Seals report will be printed 
directly to your default printer.
You can select an alternative printer by printing the report from the previewer but again 
there is no option to select the individual pages to print.

NXA85_WM_196

9.1.5 Tank Configuration Seals Report
Open the Weights and Measures → Administration screen. Select the Seal Tank 
Configuration icon from the view menu and select either Print or Preview.
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NXA85_WM_197

NXA85_WM_198

The report lists the tanks alphabetically in ascending order of tank ID. Any tanks that have 
weights and measures seals applied are indicated with seal symbols in the left hand column. 
There can be up to 4 seals per tank, one for Level (Left hand side), one for Temperature (Left 
hand side centre), one for Inventory (Right hand side centre) and one for Manual Data (Right 
hand side). The date the tank was sealed is given.

As with the Audit Trail report, the Tank Configuration Seals report will be printed directly 
to your default printer.
You can select an alternative printer by printing the report from the previewer but again 
there is no option to select the individual pages to print.

NXA85_WM_199

9.1.6 Bulk Print Reports
It is also possible bulk print selected reports directly from the main Weights and Measures 
administration screen. To bulk print reports click the reports button  in the toolbar. This 
will display a screen allowing selection of the required reports.
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NXA85_WM_201

Tick one or more reports to be printed and then click the OK button. The printer selection 
dialog will then be displayed to allow selection of the printer to which the reports are to be 
printed. There is no preview facility. When the Print button is clicked, the selected reports 
will all be printed.

9.2 Stock Reports
There is a standard set of reports that accompany the Tankvision Professional application. 
These can be viewed or printed from the home page or scheduled from the Report Scheduler 
Service and may be spooled to any printer connected to the PC.
For reports to comply with Weights and Measures approval they may only be printed on a 
secure printer. An Eichprinter utility has been introduced to meet these requirements. The 
utility will be operated from the command line, where the name of a report template, the 
COM port and any parameters required by the template will be passed in.

9.2.1 Configuring a Report Template
The report template is an XML based document. It can be easily created or edited using 
"Notepad" or a similar application.

The template consists of the following elements:
• <template>
• <page>
• <filters>/<filterBool>/<filter> (optional)
• <header>
• <detail>
• <footer>
• <text>
• <field>

<template>

The document element for the report template. All other elements are contained within this 
element.

<page>

There is always exactly one "page" element in the template, it is used to define the size of the 
paper among other details.

Attribute Description

horizontal Width of the page in chars (e.g. 132)
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<filters>/<filterBool>/<filter>

There may be one ‘filters’ element in the template. It defines the parameters that the report 
takes and how they apply to the data set. If the filters element is missing or empty it is 
assumed that there are no filters to be applied to the report and all tanks will be output. 
There can be a single <filterBool> or <filter>element within <filters>.
A <filterBool> must contain 2 <filter> elements, although each filter may be replaced with 
a filterBool. In this way several filter elements can be contained within one <filters> 
element.

<filterBool> defines how the filterBools and filters it contains are combined applying either 
“or” or “and” logic.

<filterBool>

There can be any number of <filter> elements within <filterBool>.

<filter>

<header>

The header section defines the top lines of the report and is repeated on every page. The 
header section contains a height attribute that defines the number of lines the header 
section will fill. The layout of the data within the header will be defined by a number of 
<field> and <text> elements.

<detail>

The detail element describes the layout of the data that will appear in the body of the report. 
A detail row is repeated once for every tank in the data set. The detail row includes a height 
attribute so can consist of more than one line of data if required.

<footer>

The footer section is similar to the header section except it is repeated at the bottom of each 
page. The vertical height available on the page for details is reduced by the size of the header 
and footer lines.

vertical Height of the page in lines (e.g. 88)

leftMargin Offset applied to left-most field positions

rightMargin Offset applied to right-most field positions

topMargin Offset from top of page in lines

bottomMargin Offset from bottom of page in lines

Attribute Description

operator Either “And” or “Or”

Attribute Description

id Unique name for the filter – this will be used to identify the parameter values from 
the command line

mode Either exclude or include

type One of Tank, Shape, Product or Group

Attribute Description
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<text>

A text object can be placed in either the header, footer or detail sections and describes a fixed 
piece of text that will appear on the report.

<field>

A field object describes a piece of data that will be displayed on the report. Field objects can 
be placed in the header, footer and detail sections.

Example Template

The example below defines a report that will provide Product Level, Temperature and 
Gauged Volume data for specified tank IDs OR tanks containing specified products.
The page height is set to 35 lines less 4 lines for the header and footer. This leaves 31 lines 
per page for details. The details height is 5 lines  so we can fit the details of 6 tanks onto a 
single page (6 × 5 = 30 lines). The remaining line is ignored as details sections will not be 
split across pages.

Attribute Description

X Horizontal position of field (zero-based, negative values indicate that the horizontal 
position is offset from the right of the form).

Y Vertical position of field (zero-based, negative values indicate that the position is 
offset from the bottom of the field. Note that negative values are only appropriate 
for the footer.

Alignment Left, Right, Centre – default is Left.

Width The number of character positions occupied by the field.

wrapText 1 – text overrunning the width of the field is moved on to the line below. 
0 – text is truncated by the width of the field.

Attribute Description

X Horizontal position of field (zero-based, negative values indicate that the horizontal 
position is offset from the right of the form).

Y Vertical position of field (zero-based, negative values indicate that the position is 
offset from the bottom of the field. Note that negative values are only appropriate 
for the footer.

Alignment Left, Right, Centre – default is Left.

Width The number of character positions occupied by the field.

wrapText 1 – text overrunning the width of the field is moved on to the line below.
0 – text is truncated by the width of the field.

Numeric fields cannot be wrapped and will be replaced with asterisks.

fieldName One of the field names from Appendix: Data Fields (detail section) or Appendix: 
Report Fields (footer and header sections)
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The image below shows the results obtained from the Demo Database if the input 
parameters are 
Tank = TK001 & TK003 and 
Product = LPG.
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9.2.2 Selecting Output Method
When printing, it is not possible to specify a printer. Instead the COM port that the printer 
is connected to and the serial communications parameters must be specified in the 
command line when printing a report. The default communications parameters are 9600 
baud, Even parity, 7 bits, 1 stop bit.
When exporting a report to file the filename and path will replace the COM port and 
communications parameters.

Whether printing or exporting to file the executable to be run is 
Weights.And.Measures.Reports.exe. This executable can be found in the directory in 
which Tankvision Professional is installed.

Other command line parameters that must be specified are the Report template path and 
filename and any parameters mentioned in the template.

Parameter Necessity Description

-t xxxx Mandatory Use template file xxxx to format the report.

-o yyyy Optional Output to device yyyy, where yyyy is a serial port on the computer 
(e.g. COM1). 
Cannot be specified with -f.

-f zzzz Optional Output to file zzzz, where zzzz is the path to the output file.
Cannot be specified with –o.

[Parm1=Value] Optional Report parameters are defined by the report template.
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So in the example above, to print the report from a template saved on the C: drive and 
requiring data on products DERV and LNG with additional tank TK003 the command line 
instruction would be:

Weights.And.Measures.Reports.exe -t "C:\Example Report.xml" -o "COM1, 9600, E, 7, 
1" ProductName="DERV, LPG" TankName="TK003"

And to export the same report to file the command would be :

Weights.And.Measures.Reports.exe -t "C:\Example Report.xml" -f "C:\Example 
Report.txt" ProductName="DERV, LPG" TankName="TK003"

Where "C:\Example Report.txt" is the path and filename of the file to be saved.

9.3 Scheduling Reports
It is not possible to schedule report printing using the command line, however the Report 
Scheduler Service in Tankvision Professional can be used for this purpose.
Right click the Tankvision Professional Service Manager icon in the system tray and select 
Report Scheduler Config.

NXA85_WM_100

In the Properties window right click Default to add a Batch.
Right click Batch to add a report and select the saved .xml report template.

NXA85_WM_101

Configure the report settings:
• General Settings – Ensure that Print Enabled is marked as True. Set the remaining 

settings as required.
• COM Parameter Settings – Select the COM port connected to the secure printer. Set the 

communications settings to 9600 baud, Even parity, 7 bits, 1 stop bit.
• Parameter Settings – The parameters used by the report template will be shown. Enter 

the required parameters for the report, separate multiple parameters by commas.
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Right click Batch to add a trigger for the report.

NXA85_WM_103

9.4 Direct Printing of Reports
To simplify the printing of reports it is possible to configure buttons for “On Demand” 
printing from SCADA screens or the Home Page.
Any such reports will have fixed parameters which are set when the button is configured.

9.4.1 Adding Buttons to the SCADA Screens
Open Design mode for the required SCADA screen and Right click in an empty space to open 
the context menu.
Select Add Item → Add Button.
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Select the new button object and right click to add the Weights and Measures Reports printer 
executable.

NXA85_WM_105

The Weights.And.Measures.Reports.exe file can be found in the Tankvision Professional 
installation directory.

It is also necessary to pass the following arguments to the executable:
• The path and filename of the Report template.
• The output method, → ä 63.
• Any filter parameters required by the report template.

Select the button object and right click to set the arguments to pass to the executable. In the 
Arguments window type a single string containing the data detailed above.
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For the example (→ ä 63) the Arguments string would be:
-t “C:\Example Report.xml” -o “COM1, 9600, E, 7, 1” ProductName=”DERV, LPG” 
TankName=”TK003”

The button itself can be customized for Text, Picture and Colours in the normal way.
Once the button has been configured Exit and save the SCADA design window.
Simply open the SCADA window and click the button to print the report.

9.4.2 Adding Buttons to the Home Page
There is a file called HomePage.Toolstrips.xml in the Tankvision Professional directory 
which defines the layout of the menus and toolstrips on the tank gauging home page. This 
can be edited to add buttons to any of the menus and toolstrips.

NOTICE
Errors may affect normal operation
Any errors made when editing this file may affect the normal operation of the Menus and 
Toolstrips.
‣ Take extreme care when editing this file.
‣ It is recommended that a backup of the file is taken before modifying the contents and 

changes are only made by persons experienced in editing XML files.

Edit the HomePage.Toolstrips.xml using an application such as Notepad to add buttons to 
a toolstrip.
The information for the toolbars are is held in <ToolStrip> nodes and similarly menu 
information is held in <ToolStripMenuItem> nodes.
Items defined as <LaunchExeButton> nodes cause a Windows executable file to be launched 
when clicked so can be used to add a Print Report button to the Home Page.
Select where the button is to be situated (The recommended site is the ShortcutBar) and add 
a <LaunchExeButton> node.

The node must have the following attributes:
• ToolTipText – The text to be displayed in the tooltip for the toolbar item. If this is omitted 

or left blank, no tooltip will be displayed. Strings which begin and end with a ‘#’ are used 
to locate language strings in text.xml, if the string entered does not have ‘#’ symbols 
around it then the value for this attribute is displayed as entered.
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• Exe – The executable file to be run when the toolbar item is clicked. This must be 
Weights.And.Measures.Reports.exe. The file is located in the Tankvision Professional 
directory.

• Args – The arguments for the report. The whole argument must be enclosed by double 
quotes and filenames for the report template.and export destination may not contain 
spaces.
Example: Args=”-t C:\ExampleReport.xml -o COM1, 9600, E, 7, 1 ProductName=DERV, 
LPG TankName=TK003”

• ImageFile – The name of the .ico file to be used as the icon on the toolbar button. This file 
must be located in the icons subdirectory under the Tankvision Professional directory.

NXA85_WM_109

The file must be saved as a .xml file and the Home Page closed and reopened to read the new 
configuration. The extra button(s) should now be visible and clicking this will run the report.

NXA85_WM_202
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10 Appendix A – Server Configuration
For a secure, encrypted connection to be established with the SQL Server database on the 
server machine it is necessary to set a certificate to be used for encryption on the database. 
There are potentially a number of steps that need to be performed to achieve this.

10.1 FQDN (Fully Qualified Domain Name)
The server machine must have an FQDN (fully qualified domain name). If the machine is a 
member of a domain it will already have an FQDN. However, if the machine is a member of 
a workgroup it will be necessary to either join a domain or set a primary DNS suffix.

The steps to do this depend upon the version of Windows that is being used. It is assumed 
that anyone attempting this is competent enough to be able to deal with the variations 
within newer versions of Windows. In Windows Server 2008 setting the FQDN can be done 
by opening the Windows Control Panel and navigating to the ’System’ page:

NXA85_WM_203

On this page, click the Change settings option. This will bring up the system properties 
screen:
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Click on the Change... button. This will bring up the Computer Name/Domain Changes 
screen:

NXA85_WM_205

To join a domain, ensure that the ’Domain’ option is filled and enter the name of the domain 
to which the machine is to be joined. Then click the OK button. To set the Primary DNS Suffix 
click on the More… button.
This will bring up the DNS Suffix and NetBIOS Computer Name screen:
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Enter the new Primary DSN suffix for the computer and then click the OK button.
When these settings have been changed it is necessary to restart the machine before 
continuing.

10.2 Obtaining a Certificate
Once the server machine has an FQDN it is necessary to obtain a certificate which can be 
used by SQL Server. The certificate must satisfy these conditions:
• The certificate must be either in the local computer certificate store or the current user 

certificate store.
• The certificate must be meant for server authentication. This requires the Enhanced Key 

Usage property of the certificate to specify Server Authentication (1.3.6.1.5.5.7.3.1).
• The certificate must be created by using the KeySpec option of AT_KEYEXCHANGE.
• The subject property of the certificate must indicate that the common name (CN) is the 

same as the host name or fully qualified domain name (FQDN) of the server machine.

It is possible to check if a certificate already installed on the machine is suitable to be used 
to encrypt the connection. To do this, open a command prompt as an administrator and type 
the following:
CERTUTIL –v –store –user “my” “name” > “path”

This will dump the certificate details from the current user certificate store. To dump the 
certificate details from the local computer certificate store omit the –user switch. The 
“name” parameter is the name of the certificate for which details are required. If this is 
omitted, details of all certificates in the specified store are output. The “path” parameter is 
the full path of the file to which the details are to be dumped. Once the command has been 
run open the output file and check for the following details:
The NotBefore date/time must be prior to the current date/time and the NotAfter date/time 
must be after the current date/time.

The subject must indicate that the common name (CN) is the FQDN of the server machine.
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The key container must include the KeySpec of AT_KEYEXCHANGE. The enhanced key 
usage must either be absent completely or include Server Authentication.
If there is not a suitable certificate installed on the machine it is necessary to install one. If a 
suitable certificate is available it can be imported into the certificate store, otherwise it is 
necessary to obtain a certificate either from a certification authority (recommended) or 
generating a self-signed certificate.

10.2.1 Importing a Certificate
The easiest way to import a certificate is to use the Microsoft Management Console (MMC). 
Press the Windows Start button and type MMC:

NXA85_WM_208

Select mmc. The Microsoft Management Console will be launched:
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Open the File menu and select Add/Remove Snap-in.... The ’Add or Remove Snap-ins’ 
screen will be displayed:

NXA85_WM_210

Select the Certificates entry from the list of ’Available snap-ins’ and click the Add > button:
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Select the certificate store into which the certificate is to be imported (either ’My user 
account’ or ’Computer account’. Do not select ’Service Account’. Click the Finish button. 
Then click OK on the Add or Remove Snap-ins screen. The Certificates snap-in will now be 
present in the console:

NXA85_WM_212

Expand the tree in the left-hand pane and then select the Personal/Certificates entry. From 
the Action menu select All Tasks and then Import…:
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The Certificate Import Wizard will be launched:

NXA85_WM_214

Click the Next button.
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Enter the full path of the certificate file to be imported, or click the Browse… button and 
select the file. Click Next:

NXA85_WM_216

Choose to place the certificate in the Personal certificate store and then click Next.
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Check that all the details are correct and then click the Finish button. The certificate will 
then be imported.

10.2.2 Obtaining a Certificate from a Certification Authority
To obtain a certificate from a certification authority (such as Comodo, Verisign or Thawte) it 
is necessary to supply them with a request file. The easiest way to generate a request file on 
Windows without installing IIS is to use the CertReq utility. CertReq takes the details 
provided in a configuration file and uses them to generate a request file. The configuration 
file should be created with an INF extension and contain the following:

NXA85_WM_218

The ‘Subject’ entry should be modified to include the relevant company details etc. The ‘CN=’ 
part must match the FQDN of the server that is to be certified. In theory the other parts in 
the subject entry are optional, but the certification authority will probably insist that they are 
present. Possible parts are:

X509 Field Description

C= 2 character country code (e.g GB, DE, US)

ST= Area/Region/District/County (e.g. North Yorkshire, Westphalia)
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Once the INF file has been created a request file can be generated by using the CertReq 
utility. Open a command prompt as an administrator and then type:
CertReq –new certreq.inf request.req
Where certreq.inf is the full path to the INF configuration file and request.req is the full path 
of the request file to be generated. The request file produced can then be submitted to a 
certification authority to produce a certificate for the server. How this is done depends on the 
certification authority and what checking they require to certify your server. At the end of 
the process the certification authority will provide a cer certificate file which can be imported 
into the system as described in the previous section.

10.2.3 Creating and Installing a Self-Signed Certificate
To create a self-signed certificate it is necessary to have MakeCert.exe installed on the 
machine. This is a Microsoft tool found in the Microsoft SDK. To create a self-signed 
certificate and install it in the certificate store open a command prompt as an administrator 
and type the following:
Makecert –r –pe –n “CN= DOBBIN64.sedbury.mht-technology.co.uk” –b 01/01/2000 –e 01/
01/2036 –eku 1.3.6.1.5.5.7.3.1 –ss my –sr localmachine –sky exchange –sp “Microsoft RSA 
SChannel Cryptographic Provider” –sy 12
The machine name referenced in the common name (CN) value should be the FQDN of the 
server machine to be certified.

10.3 Specifying a Certificate for SQL Server
From the Windows Start menu select All Programs → Microsoft SQL Server xxxx → 
Configuration Tools → SQL Server Configuration Manager. The SQL Server Configuration 
Manager utility will be launched:

NXA85_WM_219

Expand the entry for SQL Server Network Configuration and select the Protocols for 
MSSQLSERVER entry:

L= Location

O= Organisation

OU= Organisational Unit

CN= Canonical Name (Fully Qualified Domain Name)

X509 Field Description
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From the Action menu select Properties. The ‘Protocols for MSSQLSERVER Properties’ 
screen will be displayed:

NXA85_WM_221

Click on the ‘Certificate’ tab and then select the certificate to be used to encrypt the 
connection. If no certificates are available in the list, then no suitable certificates have been 
installed on the machine. Once a certificate has been selected click the OK button. SQL Server 
is now set up to accept encrypted connections. SQL Server will need to be restarted for the 
changes to take effect. Under some circumstances SQL Server will fail to start once a 
certificate has been applied. If this occurs, check the event log to find the reason. If there is 
an entry with an event ID of 26014 and a description similar to:
Unable to load user-specified certificate [Cert Hash(sha1) 
"75AA215E7A0598919032926E00DFB4EAB63A13EB"]. The server will not accept a 
connection. You should verify that the certificate is correctly installed. See "Configuring 
Certificate for Use by SSL" in Books Online.
it is because the Network Services account doesn’t have access to the private key  containers 
on the system.  In this case there are two solutions. The first is to alter the SQL Server service 
settings to run under the Local System account. The second (and preferred) solution is to 
grant access rights to the certificate to SQL Server. To do this, open MMC and add the 
Certificate snap-in as detailed in Importing a certificate. Select the certificate being used by 
SQL Server and then select All Tasks → Manage Private Keys… from the ‘Action’ menu:
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This will bring up the permissions screen for the certificate:

NXA85_WM_223

Click the Add... button to add the SQL Server user to the list of users which have access to 
this certificate:

NXA85_WM_224
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In the text box type:
machine\SQLServerMSSQLUser$machine$MSSQLServer
where machine is the name of the server. Check the name. There is some variation between 
versions of Windows and versions of SQL server as to the account name that SQL server 
creates for its use when it is installed. If the name is not recognised try MSSQLSERVER 
instead. Click OK and then click OK on the Permissions screen. SQL Server should now start 
successfully.
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11 Appendix B – Client Configuration
To allow a client machine to communicate with SQL Server on the server machine using an 
encrypted connection it is necessary to install the certificate on the client machine.

11.1 Exporting the Certificate
On the server machine launch the Microsoft Management Console and add the certificates 
snap-in as detailed in Importing a certificate. Select the certificate which is being used by SQL 
Server and then select All Tasks → Export… from the Action menu:

NXA85_WM_225

The certificate export wizard will be launched:

NXA85_WM_226
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Click on the Next button:

NXA85_WM_227

It is not necessary to export the private key. Click the Next button:

NXA85_WM_228

The default option of DER encoded binary X.509 is the option that should be used. Click the 
Next button:
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Enter the full path to the file to be created, or select it using the Browse… button. Click the 
Next button:

NXA85_WM_230

Check that the details are correct and then click the Finish button. A message should be 
displayed:
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Click OK. The export file will have been created at the specified location.

11.2 Importing the Certificate
Copy the exported certificate to the client machine and then click on the file using the right 
mouse button and select Install Certificate:

NXA85_WM_232

The Certificate Import Wizard will be launched:
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Select the Current User store location and then click the Next button:

NXA85_WM_234

Select the option to explicitly select the store for import and then use the Browse… button 
to find the Trusted Root Certification Authorities certificate store. Click the Next button:
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Check the details and then click the Finish button. A Security Warning may be displayed:

NXA85_WM_236

Click the Yes button. A message will be displayed:

NXA85_WM_237

The certificate should now be visible in the Windows certificate snap-in and it will be 
possible to encrypt the connection with the server in the Weights and Measures 
Administration module.
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